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1. General Description  

1.1. Development History 

The original software named Spekwin (16bit version) was developed in the Daltrozzo group at 

the Universität Konstanz in 1997-1998 by Dr. Claus Vielsack with DELPHI1. It was based on an 

even earlier attempt to create software for spectra display undertaken by Dr. G. Kollmannsberger 

with TURBO PASCAL (DOS program tpbld.exe, until 1994). Since 1999, further development is 

done by me. At present there is the 32bit-Version Spekwin32 (developed with DELPHI 4) with 

enhanced functionality and much increased working speed for some functions. The bigger part 

of  the work took place during my Ph.D. time at the Daltrozzo group from 2000-2005. 

1.2. Description 

One main goal of  Spekwin32 is the consistent display of  spectra coming from different sources. 

At the moment, 19 different spectral file types from commercially available spectrometer systems 

can be read. Spekwin32 is able to handle UV/VIS, fluorescence, NIR, IR and Raman spectra 

while the main focus is on UV/VIS and fluorescence. 

 Spekwin32 allows doing many tasks on (series of) spectra that come across in the laboratory 

everyday life (baseline correction, spike removal, normalization, smoothing, averaging, integra-

tion, finding peaks, calculation of  concentration via Lambert-Beer, absorption coefficient and 

oscillatory strength ...). 

As important features for fluorescence spectroscopy there are: calculation of  degree of  polariza-

tion, center of  gravity, fluorescence quantum yield; correction of  excitation intensity of  fluores-

cence spectra, calculation of  excitation spectra from two-dimensional fluorescence spectra, 

displaying two-dimensional fluorescence spectra (EEM) from series of  fluorescence or excitation 

spectra. 

To simulate absorption spectra, there is an algorithm that allows fitting of  any group of  curves 

(Gauss type) to present spectra. 

For simple documentation, any number of  spectra can be saved together as proprietary Spek-

win32 binary file or as two sorts of  human readable ASCII files (*.dat and *.csv). Spectral data 

can also be exported into two commonly accepted spectra file formats: JCAMP-DX and 

THERMO Galactic/GRAMS spc files. The current plot can be printed, copied to the clipboard 

or saved as graphics (WMF, GIF, TIFF, BMP, and PNG). For LaTeX freaks, Gnuplot parameter 

files and data files can be created that allow producing EPS files directly. 
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1.3. System Requirements/ Installation  

Spekwin32 will work with Win95/98/ME and WinNT/2000/XP/Vista/7. Hardware require-

ments are minimal; it will even run on a 486CPU/25MHz/16MB. The downloaded file will install 

the full english version, including the HTML manual. There is also a german version available. 

The initial user status will be „unknown“, please change this to your appropriate status when you 

are first running Spekwin32.  

1.4. Terms of Use 

Spekwin32 is provided as freeware for non-commercial, private, academic and educational use, 

this includes also non-profit organization (i.e. schools, universities, UN organizations, public 

authorities, police, fire brigade, hospitals). In this case, you are granted the right to use and to 

make an unlimited number of  copies of  this software. 

Commercial use is not authorized without agreement or ordering. After an appropriate 

trial period, you will have to purchase a one-time licence. This licence entitles you to get 

free updates and free basic mail support. A single licence is valid for either a single user 

on several computers or several persons on a single computer, but not for several persons 

on several computers. Licence purchase and payment can be done via J-M-S 

(http://www.j-m-s.de/index_e.htm), the single licence price is 95€ (excluding VAT), 

there are also deep discounts for multiple licences. 

Spekwin32 is copyright-protected. The software is only available via the author's website, no one 

else is allowed to distribute it or sell it, except with the author's permission. The software must 

not be modified; you may not decompile or disassemble the software or any parts of  it.  

Spekwin32 is provided "as-is" and without warranty of  any kind, express, implied or otherwise, 

including without limitation, any warranty of  merchantability or fitness for a particular purpose. 

In no event shall the author of  this software be held liable for data loss, damages, loss of  profits 

or any other kind of  loss while using or misusing this software. 

1.5. Scientific citations 

If  you use Spekwin32 in your scientific work, please reference to the software as: 

F. Menges "Spekwin32 - optical spectroscopy software", Version x.xx.x, 201x, 

http://www.effemm2.de/spekwin/ 

Please insert the current version number and the year of  compilation from the Help => about 

Spekwin32... window. You may leave out the part in quotation marks. 

(And please: try to get the spelling right! It's not "Specwin-32" and not "Speckwin 32", there is no 

blank and no hyphen between "Spekwin" and "32", just write Spekwin32!)  
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2. Main Window and Main Menu 

2.1. Main Menu 

All functions (except Zoom/Rescale) are accessed via the Main Menu.  

2.2. Icon Bar 

The most important functions can also be accessed via the icons of  the Icon Bar. The function 

of  icons is shown with the mouse pointer shortly hovering above them. 

2.3. Graph Window 

The Graph Window is always visible, consisting of  axes with axis titles, loaded spectra and legend 

with corresponding legend texts. As x axis types, there can be wavelength, wavenumbers and 

electron Volts; as y axis types, there is transmittance (or reflectance), absorbance (or intensity), 

epsilon or log(epsilon) available 

 Axes might be changed in [Plot/Options]→[Axes]. The font of  axis ticks might be changed in 

[Plot/Options]→[Axes Font], the font of  axis titles and legend titles might be changed together in 

[Plot/Options]→[Legend Font]. These might also be permanently changed in [Plot/Options]→ 

[Configuration]. The properties of  spectra display (colour, line type, line width) and the corre-

sponding text of  the legend title can be changed in [Spectra]/[General].  

The mouse buttons are for zooming in and out. Select the zoom range with the left mouse 

button. The program then zooms in to the next axis ticks for a straight axis numbering.  The 

middle mouse button redraws the graph window. The right mouse button does a rescale, all 

spectra will be displayed completely.  

The legend box can be moved with the left mouse button. It might be hidden with 

[Plot/Options]→[Legend on/off]. 

2.4. Status Bar 

The Status Bar at the lower edge is divided in three parts: 

• On the left, the current number of  loaded spectra is shown. 

• On the middle, various program messages will be shown. 

• On the right, the current mouse position (x axis | y axis) is continuously shown in units 

of  the graph axes. 
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3. The FILE Menu  

The File menu contains all functions to Open, Save, Print and Export spectra. 

At the bottom you will find a list of  the most recently used Spekwin32 files (*.csv).  

3.1. Menu Item [Open]  

Several files can be selected simultaneously in the usual manner. While loading the selected 

spectral files, the status of  the reading procedure is displayed in the middle part of  the status bar. 

If  possible, the x and y axis types are chosen according to the most recently opened spectral file. 

The following file formats are currently recognized (you will find a collection of  sample files at 

the Spekwin32 website): 

*.asc : • ASCII file format of  absorption spectra of  the Milton Roy MR3000 diode array 

absorption spectrometer. The y axis type of  the file is detected automatically.  

• ASCII file format of  absorption spectra of  the Beckman Coulter DU 600/7000 

absorption spectrometer.s. 

*.csv : ASCII file format (csv = comma separated values) of  spectra from different sources: 

• absorption spectra of  the Varian Cary 50 absorption spectrometer (Software: Cary 

WinUV). Spectra in transmittance and absorbance will be read.  

• absorption spectra of  the Hewlett Packard 8453 absorption spectrometer.  

• IR spectra of  Bio-Rad FTS 3000 MX spectrometer (software: Varian Resolution Pro) 

• absorption spectra of  Scinco Neosys 2000 spectrometer (Software: Lab Pro Duo)  

• absorption spectra of  WTW photoLab spectral software  

• absorption spectra of  the Thermo Electron Helios Alpha spectrometer  

• multicolumn (1 - many), multiformat (all spectral types) csv file, produced by Spek-

win32 itself 

*.dat 

 

: Spekwin32 ASCII file format. Contains any number of  spectra together with their 

legend title. The program always takes the y values as absorbance, so be careful if  you 

saved spectra in a different y scale type. 

*.dx : JCAMP-DX 4.24/5.00 -file format of  UV/VIS, Raman and IR spectra. NMR and MS 

spectra will not be read!! DIFDUP and ASDF coded spectra will not be read either. 

Tested Perkin Elmer software: UVCSS & FLDM (DOS software), UV-Winlab & FL-

Winlab. Further Test spectra were available from Bio-Rad DigiLab, Mattson Instru-

ments, Galactic Industries Lab Calc and GRAMS, Sadtler, Jasco HPLC System, NIST 

Chemistry WebBook, the IUPAC JCAMP site and Robert J. Lancashire's JCAMP site. 

*.fak : Simple ASCII file format for import of  your own data. Tab separated XY Pairs, one 

pair per line, point or comma as decimal separator, optional header: if  the first line 
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reads wavenumbers or 1/cm or cm^-1 or cm-1 the x axis type is assumed to be wavenum-

bers, default is wavelength in nm. Automatic query dialog for axis types if  unclear 

from file. 

*.ggg : File format of  one of  our home built spectrometers. 

*.prn : ASCII file format of  Princeton Instruments WinSpec 1.6 (16Bit) software for CCD 

cameras from Princeton Instruments. Save in Winspec as ASCII-1 or ASCII-XY. 

*.scn  Binary file format of  absorption spectra of  the Beckman Coulter DU 600/7000 

absorption spectrometer.s. 

*.sp : Binary and ASCII file formats of  absorption, fluorescence, IR & Raman spectra of  

PERKIN ELMER spectrometers. Tested Software: UVCSS (DOS software), CFS 

(DOS software for LS-3B, LS-4B and LS-5B), UV WinLab, FL WinLab. Perkin Elmer 

Raman test spectra were available from S. B. Engelsen's Database on Raman Spectra 

of  Carbohydrates. Fluorescence spectra's ordinate values get divided by 250 before 

they are displayed. 

*.spc : Thermo Fisher's binary spectral file format (originating from Galactic Industries Corpora-

tion). Software: GRAMS/AI. Quasi standard used by quite a lot of  other vendors (e. g. 

Ocean Optics, Jobin Yvon Horiba). Tested spectral types: UV/VIS, NIR, FTIR, 

Raman, fluorescence. Will not read spc files from EDAX XRF analyzers, this is a 

different file format. For those files, use the "EDAX Spectrum Viewer". 

*.spe : Binary file format of  Roper Scientific / Princeton Instruments WinSpec/WinView 

Software (16bit and 32bit). Possible x axis types are wavelength, absolute and relative 

wavenumbers (for Raman spectra). 

*.spk  ASCII file format of  absorption spectra of  the IKS XDAP diode array absorption 

spectrometer (IKS is now axeon in Oberhausen/Germany). 

*.spv : Spekwin32's own binary file format. Contains arbitrary numbers of  spectra. Legend 

titles and other properties of  individual spectra are saved.  

Changed file format in versions 1.68.1 and 1.69.2! Earlier program versions are not 

able to read later *.spv spectral files.  

*.trt 

*.tat 

*.ttt 

*.tit 

 ASCII file format of  the Avantes software. Tested: Avantes SpectraWin Basic 5.0 and 

Avantes Avasoft 6.1. Measuring modes are:  

trt: "Scope"  

tat: "Absorbance"  

ttt: "Transmittance"  

tit: "Irradiance" 
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3.2. Menu Item [Save]  

This menu item will save the current content of  the graph window.The graph will be saved with 

the file name and file type from the last use of  [Save as...]. On first use, "Save as..." dialog will 

appear.  

3.3. Menu Item [Save as…]  

Used for saving current spectra / current graph. A "Save as..." dialog appears for file name, type 

and path. 

There are 10 file formats to select from: 

• spv files for fast and space-saving storage and reading in again of  spectra in any composition. 

• spc files for saving of  single spectra in Thermo Fisher's quite common file format.  

• dx file for saving single spectra in the world-wide used, IUPAC-proposed standard file format 

JCAMP-DX.  

• dat files for import of  values into graphing programs like Origin or Sigmaplot. Multiple 

spectra get interpolated onto a single common x column. 

• csv fore easy export of  the original spectral data for Excel and the like. Multiple spectra 

contained as separately xy paired columns. 

• gif files for saving as internet usable pixel graphics, compressed files, 256 colours, resolution: 

1350x900 pixels. 

• bmp files for saving as lossless pixel graphics, big files, resolution: 1024x768 pixels. 

• wmf files for saving as freely scalable vector graphics of  small file size, recommended best  

use for Windows Office applications like MS Word or MS PowerPoint. 

• tif files for saving as rather small lossless compressed files with 32bit colours, best for print-

ing, resolution: 1350x900 Pixel. 

• png files for saving as small lossless compressed files, the internet picture format of  the 

future, resolution: 1350x900 Pixel. 

Hints for optimized graphics export: 

• With high resolution screen and maximized program window, the standard axes and legend 

fonts might look rather small in saved graphics. Try saving again with mid-sized Spekwin32 

window. 

• Spectra are displayed as “hairlines” when using the smallest line width. This looks fine for on-

screen display, but might be insufficient for print-outs (colours too faint). For graphics export 



 7 

it is recommended to use line width 2 or 3. Unfortunately these line widths appear to be 

much thicker in Spekwin32 than in exported graphics. 

 

3.4. Menu Item [Save for Gnuplot]  

Creates two files with the same name: a Gnuplot parameter file (*.plt) and a second file (*.tat) 

with the spectral values. The parameter file contains the necessary commands for Plot Title, Axes 

titling and scaling, second X-Axes, second Y-Axes (if  degree of  polarization is included), position 

of  the legend box and creation of  EPS file with the same name. Before saving, there is a dialog 

for configuration of  these parameters where additional commands can also be included. 

For this function the following parameter files must exist in the program folder : gexit.plt, ginit.plt, 

ginit2.plt, ginit2d.plt, pola36.plt, polaset.plt, postcol.plt, postmon.plt, wlachse.plt, wlachse2.plt. This function 

was tested with Gnuplot 3.7 for Windows (32bit).   

3.5. Menu Item [Copy Graphics to Clipboard]   

The current graph window is copied as a vector graphic to the clipboard. From there, it can be 

pasted into graphic or text processing software. For optimized graphics see hints in chapter 3.3.   

3.6. Menu Item [Copy Data to Clipboard] 

Copy all data from all current spectra to the clipboard. From there, it can be pasted into text 

processing or spreadsheet software (like MS Excel or Origin).  

Spectral data will be saved in x..y..x..y..x..y.. format (each spectrum has its own paired xy values), 

in case all spectra have the same x values, the format will be x..y..y..y.. (that is: one x column for all 

spectra). The first line contains the legend texts, second line contains x and y format for each 

spectrum. 

3.7. Menu Item [Print]  

Prints the current graph window. Select installed printers like usual. For optimized graphics see 

hints in chapter 3.3. PostScript files (*.ps) can be produced by printing to a file with a PostScript 

printer driver.  

3.8. Menu Item [Exit] 

Terminates the program. Unsaved spectra are lost! 
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4. The SPECTRA Menu 

4.1. Menu Item [General]  

Here you can change all parameters important for the display of  spectra. Further, the absorption 

path length can be set and the sample concentration can be calculated from molecular weight, 

sample weight and solvent volume.  

All values displayed and entries made belong to the current spectrum, selected in the drop down 

list at the top. The current spectrum displays as a thicker line in the Graph window. 

• Legend Title: can be changed in the upper drop down list for each spectrum. With <Up> 

and <Down> keys you can scroll through the list of  Legend Titles, the same works with the 

dialog’s [<= Back] and [Forward=>] buttons. Of  course, spectra can also be directly selected 

in the upper drop down list. All entries are automatically updated on making changes to the 

selected spectrum. With [Replace by filename] the legend title of  the selected spectrum will be 

replaced by its filename.   

 With [Change all titles...] you can work on all legend titles in a single window. The '#' character 

may be used as a wildcard with search/replace. There, it is also possible to replace the legend 

texts by their file names. 

• Line Width: can be set for any spectrum in relation to the general line width which is 

changed in menu items [Thicker lines] and [Thinner Lines]. For exporting as graphics and print-

ing, it is recommended to select line widths from 2 to 5, depending on the outcome of  the 

printed graph. 

• Temperature: For some spectral file types (*.ggg, *.gdm, *.gkl, *.gpo) the measuring tem-

perature is shown. You may enter your own values. 

• Wavelength: For some spectral file types (*.sp, *.ggg, *.prn, *.spe) the wavelength is shown 

(excitation wavelength for fluorescence spectra, detection wavelength for excitation spectra). 

You may enter your own values. The only commercial file type having it's wavelength inside is 

*.sp (Perkin Elmer fluorescence spectra). 

• Line Type: there are three line types possible which can be set for each spectrum separately. 

• Line Colour: the line colour of  the current spectrum is shown in the vertical colour field on 

the right. There are 14 different colours in the palette which cycle infinitely. The line colour 

can be set for each spectrum separately with the button [Change colour =>]. There you can 

also define your own colours. 

• Absorption Path Length: standard value is d 1cm= . Changes have an effect on y axis 

scaling with ε  and log( )ε , as well as for calculation of  concentration via the molar decadic 

absorption coefficient with the menu item [Concentration] (5.9). 
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• Concentration: standard value is 0 mol/l. For y axis scaling with ε  and log( )ε  a concentra-

tion c ≠ 0 has to be entered. After entering values for molecular weight, sample weigth and 

solvent volume, the concentration can be calculate with the button [Calculate]. 

4.2. Menu Item [Information] 

For the spectrum selected in the upper drop down list the following properties are shown: 

filepath, filename, date, description, comment1, comment2, spectrum type, solvent, absorption 

path length, concentration, wavelength, temperature, start wavelength, end wavelength, step 

width, number of  data points.  

 The text in the lower part may be copied. 

4.3. Menu Item [Normalize] 

Normalization in this context means to set the maximum y value of  the spectrum to 1. 

All spectra are normalized to 1 at their maximum wavelength in the currently displayed x axis 

range. To select a certain maximum for normalization, zoom into an x axis range where this 

maximum is the highest. Normalization changes the y values irreversibly and can be done as 

often as you want. This function is very helpful for direct comparison of  spectra.  

4.4. Menu Item [Baseline Correction]  

For correcting baselines deviating from 0. Call the function and use the mouse zoom function to 

select the range to be set to 0. The mean value of  y values in the selected region will be sub-

tracted from the spectrum as a constant value. 

 Baseline correction will be done for all spectra at once. 

4.5. Menu Item [Spike Removal]  

When using prolonged exposure times with CCD detectors, artefacts from cosmic radiation are 

increasing. These are called cosmic spikes. 

 This function detects spikes and interpolates the spectrum in the range of  the spike. All other 

spectral data points remain totally unchanged. Spectra without spikes remain also unchanged. 

Broad spikes (> 5 data points, quite rare), are not detected to make sure not to change spectral 

features. 

Select the spectrum to be treated in the upper drop down list. The treated spectrum will be added 

to the list of  spectra. 

• [Delete Original] deletes the original spectrum. 

• [Treat all Spectra] for treating all spectra, original spectra will be deleted. 
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• [Backward spike Removal] lets the detection algorithm move over the spectrum from right to 

left. In this way some more spikes might be detected. 

•  [Append "spikes removed"] appends "spikes removed" to the legend titel of  the spectrum. 

4.6. Menu Item [Correction (CCD)]  

For correction of  the wavelength dependent sensitivity of  detectors of  fluorescence spectrome-

ters. This function yields "true spectra". 

 Load the correction curve with the button [Load correction Curve] (*.fak file, has to consist of  XY 

pairs with sensitivity against wavelength). Select the spectrum to be corrected in the middle drop 

down list. The corrected spectrum will be added to the list of  spectra, the legend title will be 

appended with "corrected". 

• [delete original] deletes the original spectrum. 

• [correct all] corrects all loaded spectra and deletes the original spectra. 

4.7. Menu Item [Play] 

This is a just for fun function. The y values are transformed to tone pitches and played from left 

to right via the case speaker. The playing speed is 50 nm/second, independent of  the resolution 

of  the spectrum. 

You might even play real music on selection of  appropiate y values and wavelengths. 

4.8. Menu Item [Smooth] 

Smoothing all spectra. Smoothing intensity depends on the resolution of  spectra. 

Smoothed spectra are added to the list of  spectra, the legend titles are appended by "smoothed". 

Keep this function in mind to be a suspicious feature, it means modifying and glossing over the 

original data. 

4.9. Menu Item [Find Peaks] 

 Select a spectrum in the upper drop down list. In the lower part, a peak table will be shown. 

 The text in the lower part may be copied with Copy&Paste by using the mouse or by using the 

button [Copy Peak Data]. 

4.10. Menu Item [Integral] 

After calling this menu item, use the mouse to zoom into the x axis range to be integrated. Left 

and right border of  the zoom box are the integral boundaries. For each spectrum a separate 

message window is shown, containing the boundaries and the integral value of  the spectrum. 
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 Hint: The oscillatory strength will be shown additionally, if  the axis types wavenumbers and 

absorption coefficient are selected. Of  course, the value of  the oscillatory strength makes sense 

only for selection of  the first electronic transition for integration. The following formula is used 

to calculate the oscillatory strength f:  
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4.11. Menu Item [Cut off Spectrum Part] 

For reducing the spectral range (x scale). Select the spectrum to be cut in the middle drop down 

list and enter the boundaries. The treated spectrum will be added to the list of  spectra. The new 

spectral boundaries will be kept as long as the program runs. 

• with "all spectra of  one type", you can treat all spectra of  a certain type simultaneously. 

• [delete original(s)] deletes the original spectrum/spectra. 

• [prepend "part of:"] prepends "part of:" to the legend titel of  the spectrum/spectra. 

4.12. Menu Item [Sort] 

For changing the order of  loaded spectra.. In the left window, spectra order can be changed 

manually. Use left mouse button for selection (use SHIFT to select multiple spectra). Insert 

selected spectra with the right mouse button (above the spectrum you are pointing to). With the 

option [automatically] all spectra can be sorted automatically by three criteria in both directions: 

• <Direction> can be applied to all spectra (alphabetical and inverse alphabetical available). 

• <Temperature> only for spectra of  our home built spectrometers 

• <Wavelength> for some spectra of  our home built spectrometers and Perkin Elmer *.sp 

spectra, if  measured with a fluorescence spectrometer. For *.spe files, the laser wavelength 

will be displayed, if  they are of  Raman type. Up and down direction available. 

4.13. Submenu [Delete] 

4.13.1. Menu Item [Delete All]  

All loaded spectra are deleted. You have to confirm this before deletion takes place actually. 

4.13.2. Menu Item [Select for Deleting]  

For deleting arbitrary spectra. Select spectra for deleting on the left, bring them to the right with 

the button [>]. With [>>] you can bring all spectra from left to right at once. The same holds 

with [<] and [<<] for the opposite direction. 



 12 

With the option "delete all spectra of  one type", you can delete all spectra of  a certain type at once. 

4.13.3. Menu Item [Delete Last One]  

The last spectrum from the spectrum list will be deleted. 

 

5. The CALCULATIONS Menu 

5.1. Menu Item [Addition]  

The y values of  the two spectra selected in the drop down list will be added. [all spectra] will 

execute the operation on all spectra present, taking the spectrum selected in the lower dropdown 

list for calculation. The new spectrum will be added to the spectra list, its legend titel will be 

"Addition". [Keep legend text] will retain the original legend text for the resulting spectrum. The 

new spectrum's start and end wavelength will be determined by the overlapping range of  the two 

selected spectra, the x axis stepwidth is taken from the upper spectrum.  

5.2. Menu Item [Subtraction]  

The y values of  the spectrum selected in the lower drop down list will be subtraced from the y 

values of  the spectrum selected in the upper drop down list. [all spectra] will execute the operation 

on all spectra present, taking the spectrum selected in the lower dropdown list for calculation. 

The new spectrum will be added to the spectra list, its legend titel will be "Subtraction". [Keep 

legend text] will retain the original legend text for the resulting spectrum. The new spectrum's start 

and end wavelength will be determined by the overlapping range of  the two selected spectra, the 

x axis stepwidth is taken from the upper spectrum. 

5.3. Menu Item [Multiplication]  

The y values of  the two spectra selected in the drop down list will be multiplicated by each 

other. [all spectra] will execute the operation on all spectra present, taking the spectrum selected in 

the lower dropdown list for calculation. The new spectrum will be added to the spectra list, its 

legend titel will be "Multiplication". [Keep legend text] will retain the original legend text for the 

resulting spectrum. The new spectrum's start and end wavelength will be determined by the 

overlapping range of  the two selected spectra, the x axis stepwidth is taken from the upper 

spectrum. 

5.4. Menu Item [Division]  

The y values of  the spectrum selected in the upper drop down list will be divided by the y values 

of  the spectrum selected in the lower drop down list. [all spectra] will execute the operation on all 
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spectra present, taking the spectrum selected in the lower dropdown list for calculation. The new 

spectrum will be added to the spectra list, its legend titel will be "Division". [Keep legend text] will 

retain the original legend text for the resulting spectrum. The new spectrum's start and end 

wavelength will be determined by the overlapping range of  the two selected spectra, the x axis 

stepwidth is taken from the upper spectrum. 

5.5. Menu Item [Spectra Averaging] 

The y values of  the selected spectra (left mouse button) will be averaged. The new spectrum will 

be added to the spectra list, the legend title can be set in the lower edit field. 

5.6. Menu Item [Y Constants]  

Apply one of  four calculation types to the spectrum selected in the upper drop down list. The 

new spectrum will be added to the spectra list. 

Options:  

• with "all spectra of  one type", you can treat all spectra of  a certain type simultaneously. 

• [delete original(s)] deletes the original spectrum/spectra. 

• [append "+ | – | × | ÷ | n |"] appends calculation type and figure to the legend titel of  

the new spectrum/spectra. 

Hint: For multiplication with 2
λ  resp. 4

λ  enter x2 resp. x4 into the edit field. This feature is 

helpful when you have to display fluorescence spectra in wavenumbers. Generally you can multi-

plicate with n
λ  by entering xn (n: real number). The other calculation types are also applicable. 

5.7. Menu Item [X Constants]  

Depending on the selected calculation type, you can move spectra to left/right, stretch and 

compress along the x axis. This function works only if  the spectrum's original x axis type is 

identical with the currently displayed x axis type in the graph window. The new spectrum will be 

added to the spectra list, its legend title appended by the calculation type and the figure from the 

edit field.  

Hint: Please use this function only if  you really know what you are doing, since it modifies the 

spectra in a rather unusual manner. 

5.8. Menu Item [Derivative] 

The first, second, third or fourth derivative of  the spectrum selected in the drop down list will be 

calculated. The new spectrum will be added to the spectra list, its legend title appended by "x. 

Derivative".  
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Options:  

• with "derive all spectra", you can treat all spectra simultaneously. 

• [delete original(s)] deletes the original spectrum/spectra. 

• [smooth before derivation] uses a smoothed spectrum for the derivative function. This feature 

virtually eliminates the influence of  measurement noise. 

Hint: Even higher order derivatives can be obtained by repeated derivation of  derived spectra. 

The smoothing option is strongly recommended for all derivatives higher than the first derivative. 

5.9. Menu Item [Concentration] 

In addition to the menu item [General] (4.1), this is the second possibility to set the concentration 

for a certain spectrum. For this function, the molar absorption coefficient has to be known. The 

calculation of  concentration is done via Lambert-Beer (Equation(6)).  

All entered values apply only to the spectrum selected in the upper drop down list. Upon entry 

of  molar absorption coefficient, wavelength and absorption path length, you might calculate the 

concentration with the button [Calculate]. You can enter the maximum of  the current spectrum 

automatically with the button [Insert Peak]. 

Hint: For directly entering the concentration, use the menu item [General] (4.1). 

5.10. Menu Item [Effective Absorbance]  

For the determination of  fluorescence quantum yields it is important to know the fraction of  

light absorbed by the sample. Due to the finite bandwith of  the excitation light, this has to be 

averaged across the bandwidth range, yielding the "effective absorbance".  

The following formula is used: 

     
( ) ( )

( )

A I d

A
I d

λ λ λ
=

λ λ

∫
∫

     (1) 

with ( )A λ : absorption spectrum 

 I( )λ  : bandwidth of  excitation light 

Normally, the bandpass is a triangular function characterized by its center wavelength and band-

width. 
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5.11. Menu Item [Center of Gravity] 

For the spectrum selected in the drop down list, the center of  gravity will be calculated. I. e. the 

mean of  x values λ  resp. νɶ  weighted by the y values (absorbances ( )A λ  resp. ( )A νɶ  ) after 

the following equation:  

   
( )

( )

A d

A d

λ λ λ
〈λ〉 =

λ λ

∫
∫

   resp.   
( )

( )

A d

A d

ν ν ν
〈ν〉 =

ν ν

∫
∫

ɶ ɶ ɶ

ɶ

ɶ ɶ

    (2) 

 The current x axis range will be used as integration boundaries. The result will be shown in the 

middle part of  the status bar. 

Hint: the center of  gravity in wavelength scale does not correspond to the reciprocal center of  

gravity in wavenumbers scale: 
1−

λ ≠ νɶ  ! 

5.12. Menu Item [Transmittance/Reflectance] 

From two intensity spectra (sample and background/reference), the transmittance or reflectance 

will be calculated after T = I/I0 .  

5.13. Menu Item [Film Thickness] 

From a white-light reflectance spectrum spectrum showing interference, the thickness of  a 

single-layer thin film can be calculated. As input values, the refractive index of  the film material is 

needed together with the incident angle of  the reflected light (perpendicular illumination means 

an angle of  0°). The wavelength range used can be changed. 

The results window contains the input data, the number of  evaluated peaks and the calculated 

thickness together with a qualita measure (StDev). A StDev value higher than a few percent of  

the thickness value indicates an invalid result. 

Hint: This is a new and experimental feature, user feedback is strongly needed and important for 

the future development of  this feature! Do not use this method without cross-checking the 

results by an alternative method! 

5.14. Menu Item [Degree of Polarisation] 

When processing polarization dependent fluorescence and excitation spectra, it is often necessary 

to calculate the degree of  polarisation and a reduced spectrum. 

This can be done from two spectra with different polarizer orientations according to the follow-

ing equations: 

     
y x

y x

I I
P

I I

−
=

+
      (3) 
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  y xG I 2 I= + ⋅       (4) 

With:  G : reduced spectrum 

P : degree of  polarisation 

 xI : fluorescence intensity with crossed polarizers 

 yI : fluorescence intensity with parallel polarizers. 

The two spectra are selected in the two drop down lists. The new spectrum will be added to the 

spectra list, the legend title of  the new spectrum consists of  the legend title of  the spectrum and 

the new spectral type. 

To calculate all spectra at once, use the option [all]. This works only for spectra of  *.ggg type.  

5.15. Menu Item [FQ]  

This menu item is too complicated to explain here. Ask me directly for explanations. 

 

6. The 2D/TT Menu 

6.1. Menu Item [Correction of Excitation Intensity] 

For the correction of  the wavelength dependent excitation intensity (lamp spectrum) of  fluores-

cence spectrometers for a series of  fluorescence spectra with known excitation wavelength. 

Load the lamp correction curve with the button [Load Lamp Spectrum]. Select the range of  spectra 

to be corrected with the two drop down lists. The corrected spectra will replace the original 

spectra, their legend titles will be appended with "Excitation intensity corrected".  

Hint: The wavelength values can be entered manually for each spectrum in the menu item 

[General] (4.1).  

6.2. Menu Item [2D Spectrum (EEM)] 

For two-dimensional display of  a series of  fluorescence or excitation spectra. EEM means: 

Excitation Emission Matrix. The spectra should be connected to a wavelength and be corrected 

for excitation intensity before (see above). 

The current mouse position is shown in the lower left corner as excitation, emission and intensity 

values. On the right there are some options for display. Excitation is oriented horizontally, emis-

sion goes vertically. 

You cannot print or save the graph at the moment, there are no axes. 
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6.3. Menu Item [Calculate Excitation Spectra] 

For calculating a series of  excitation spectra from a series of  fluorescence spectra. The spectra 

have to be connected to a wavelength and should be corrected for excitation intensity before (see 

above). 

Enter the range and stepwidth of  detection wavelengths for the excitation spectra. Fluorescence 

spectra will be deleted if  [Delete Fluorescence spectra] is checked. 

6.4. Menu Item [Low Temp. QY] 

A useful explanation would go beyond the scope of  this manual.   

7. The GaussFit Menu 

These functions have been taken over almost unchanged from the 16bit version called Spekwin. 

They are working, but not unimpeachable.  

For simulating spectra with Gauss-type groups of  curves and fitting of  real spectra. Will work 

with wavenumbers only as x axis type. 

7.1. Menu Item [Manually] 

Here the real work is done. Will be described later.. 

7.2. Menu Item [Open] 

To open a previously saved dataset of  Gauss spectra (*.gss). 

7.3. Menu Item [Save] 

To save the current dataset of  Gauss spectra. 

8. The PLOT/OPTIONS Menu 

8.1. Menu Item [Configuration] 

Here you can change and set permanently many program options. The settings are written to the 

file spekwin32.ini in the program folder. Write access is needed for this file! During program 

start, these settings are read from the file. Without write access, the settings can be read but not 

written. It is recommended to install Spekwin32 to a folder with write access.  
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8.2. Menu Item [Axes]  

For interconversion of  different axis types and naming of  axis titles. For the x axis, wavelength 

and wavenumbers scale can be selected. Wavenumbers and electron volts are proportional to 

energy. The following equation holds true if  the axis units are nm and 1/cm: 

    
7

10
λ =

νɶ
   und   

7
10

ν =
λ

ɶ      (5) 

 Additionally, axis conversion to electron volts (eV) is possible. The calculation is: 

1eV=8065,5cm-1. There is an option to manually set the x axis boundaries in the [boundaries] 

window. 

The y axis values can be shown as transmittance T, absorbance A, molar absorption coefficient ε 

and log(absorption coefficient) log ε. For interconversion, the following equations are used: 

    logA T= −    and   A cd= ε      (6) 

For displaying epsilon and log epsilon you have to assign a concentration to the spectrum. This 

can be done in the menu items [General] (4.1) or [Concentration] (5.9). Additionally, the y type 

"Reflectance" and "Intensity" are recognized and handled by Spekwin32. 

If  possible, the x and y axis types are choosen automatically according to the most recently 

opened spectral file. 

The display of  axis titles can be turned off  with the option [show Axis Title]. Set your own 

individual axis title with [Set Axis Title]. 

The option [Alternating Tick Label] is enabled by default when set in the menu item [Configuration]. 

8.3. Menu Item [Axes Font] 

For changing the font of  both axes' tick labels. 

8.4. Menu Item [Legend Font] 

For changing the font of  both axis titles and of  legend titles. 

Hint: When choosing very big font sizes, the axes titles and axes labels might overlap. 

8.5. Menu Item [Legend on/off] 

For turning on and off  the display of  legend titles. 

8.6. Menu Item [Grid on/off] 

For turning on and off  the grid display. 
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8.7. Menu Item [Secondary x-Axis on/off] 

For turning on and off  the complementary second x axis at the upper edge of  the graph window. 

8.8. Menu Item [Points/Lines]  

For switching spectral display as points or lines. 

8.9. Menu Item [Flip X-Axis] 

For switching x-Axis direction. Will affect only the graphics display. Data will be saved in default 

direction. 

8.10. Menu Item [Standard Lines&Colours] 

For setting back spectral display to default values. The colours are set to default order, line width 

to 1 and line style to "solid". 

8.11. Menu Item [Thicker Lines] 

Increase the line width by one. Possible range is from 1 to 7. 

8.12. Menu Item [Thinner Lines] 

Decrease the line width by one. Possible range is from 1 to 7. 

8.13. Menu Item [Plot All Black] 

Set the line colour of  all spectra to black. To go back, call the menu item [General] once. 

8.14. Menu Item [Cycling Line Types] 

Sets the line types of  all spectra to alternate between "solid", "dotted" and "dashed". To go back, 

call the menu item [General] once. 

8.15. Menu Item [Display Values] 

Continuously shows the current x and y value for the spectrum selected in the drop down list. 

Close with [Abort]. 

8.16. Menu Item [Background Colour] 

For changing the graph's background colour. The background colour will not be plotted, ex-

ported or saved, the background remains transparent!  

 


